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Overview
The Task Manager solution organizes workflows inside and outside of OneStream. It provides
one stop for Administrators to manage and ensure the success of their processes.

Task Manager accomplishes the following:

l Assigns tasks based on close or process start dates.

l References workflows to be completed or reassigned.

l Allows for communication around tasks through email and comments.

l Provides at-a-glance charts to see task status across individual Preparers, Approvers, and
task groups.
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Setup and Installation
Note: Task Manager cannot be used on applications with a custom weekly time profile.

Use the following information to understand prerequisites and dependencies, plan your
installation, and configure the database server.

Note: Before beginning setup, verify that the SQL server has table creation rights on the
SQL database to create the custom tables.

See also:MarketPlace Solution Modification Considerations

Dependencies
Component Description

OneStream 6.3.0
or later

MinimumOneStream Platform version required to install this version
of Task Manager.

Select the Task Manager Development
Location
Before beginning installation, decide whether to build the solution directly in the Production
OneStream application or in a separate Development OneStream application. This section
provides some key considerations for each option.

Production OneStream Application: The primary advantage of building the solution in a
Production application is that you will not have to migrate the resulting work from a Development
application. However, there are intrinsic risks when making design changes to an application used
in a Production capacity and not advised.

Note: OneStream strongly recommends that you implement the solution in the
Development environment with a fresh copy of the Production application before starting
work.
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Development OneStream Application: As a best practice, use the Development OneStream
application to build the solution.

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and
change data in the additional database tables used by Task Manager. If other MarketPlace
Solutions (such as Specialty Planning) are already in the application, these adjustments may
already exist.

See also:Solution Database Migration Advice

Configure the OneStream Application Server
Be sure that the security group settings include the users working on and setting up Task
Manager before proceeding.

Note: Group settings are applicable to all MarketPlace solutions; it is important to keep the
group names generic.

1. Start the OneStream Server Configuration Utility as an Administrator.

2. ClickOpen Application Server Configuration File > Database.

3. Edit the followingOneStream Database Server properties:

l Access Group for Ancillary Tables: Select a group that includes those who access
records.

l Can Create Ancillary Tables: True.

l Can Edit Ancillary Table Data: True.

l Maintenance Group for Ancillary Tables: Select a group who edit and maintain tables.
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l Table Creation Group for Ancillary Tables: Administrator.

4. Restart Internet Information Server.

Install Task Manager
1. On the OneStreamMarketPlace Dashboard, clickMarketPlace > Task Manager.

2. On the Task Manager Solution page, select the appropriate OneStream platform version
from the Minimum Platform Version drop-down list.

3. Select the most recent version from the Solution Version drop-down list and click
Download.

4. Log in to OneStream.

5. On the Application tab, click Tools > Load/Extract.

6. On the Load tab, locate the solution package using the Select File icons and clickOpen.
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7. Click Load when the solution’s file name displays.

8. Click Close to complete the installation.

Set Up Task Manager
The first time you run Task Manager, you are guided through the table setup process.

l In OneStream, clickOnePlace > Dashboards > Task Manager > Task Manager.

Create Tables and Launch Solution
1. Click Step 1: Setup Tables.

This step may be necessary when upgrading even if tables already exist. Task Manager
does not drop any tables that already exist, but modifies table structures and adds new
ones if necessary.
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2. When setup is complete, click Step 2: Launch Solution to open Task Manager.

Package Contents
The Dashboard Maintenance unit provides the user interface for Task Manager and includes the
required dashboard groups, components, data adapters, parameters and files.
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Settings
The Settings page contains the Global Options tab in which key properties that guide
administration are set as well as Close Dates, Categories, Instructions, Holiday Profiles,
User Preferences, Mass Updates, XFDoc Add-Ins, and Uninstall options.

Global Options
TheGlobal Options page contains key properties that guide global Task Manager
administration. It should be the first page accessed during the initial setup and configuration of
Task Manager.

Note: All Global Options settings are retained during solution upgrades.
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Security Role [Manage Task Setup]
The user group assigned to this role determines the global Task Manager Administrators. Users
with this role are granted access to all areas of Task Manager and are the only users who can
access the Settings page.

Email Connection
The named email connection to use for notifications. The name of the connections in this drop list
derives from the initial server configuration. See the Installation and Configuration Guide for more
information on configuring an email connection on your server.
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Close Has Work Day Zero
This setting controls the numeric work day values and work day offsets when the Due Date
MethodGlobal Option is set to Derived.

l If set to Yes, then Day 0 (zero) is considered the first day of the close in the Work Day list.
This is the default setting.

Example:

o Close Date = 7/1/2020

o Task Work Day = 0

o Task Start Date = 7/1/2020 (Close Date)

l If set to No, then Day 0 (zero) is not included in the Work Day list and Day 1 (one) is
considered the first day of the close.

Example:

o Close Date = 7/1/2020

o Task Work Day = 1

o Task Start Date = 7/1/2020 (Close Date)

The Close Has Work Day Zero check box has no effect on negative task workday values.

Important: Set this option at the beginning of the setup process and do not change it. If you
change this setting after creating tasks, then you must perform a mass update and republish
to change the value of all existing Day 0 (zero) tasks.

Due Date Method
The Due Date Method determines the process used to compute the start and due dates of a task
in relation to the configuration of close dates.

Derived
The start date and due date use the following calculation to get their values:

Task Manager Guide 9

Settings



l Start Date = Global Close Date + Task Work Day Offset

l Due Date = Start Date + Duration

Explicit Day Map List
Looks up the start date in the Close Date (Day Map) field and computes the due date the same
as Derived. This method helps when requiring very specific dates for certain months to avoid
certain non-working days to apply offsets.

l Start Date = Day Map Close Date (Looked up by theGlobal Close Day & Work Day
value)

l Due Date = Start Date + Duration

Holiday offsets are honored for both derived and explicit day map due date methods.

See also: Close HasWork Day Zero

Published tasks display an error message in the Task Gantt Viewer if Close Date (Day Map) has
not been set up for a workflow period when the Due Date Method setting is set to Explicit Day Map
List.

Start Hour Method
This setting controls how to compute a task’s start and due date hours.

Offset Close Start Hour
Derives the task start hour by adding the Task Work Hour Start (offset, +2) value to the Close
Start Hour value.

If the Task Work Hour Start Offset value is set to (None), then the start hour is the close start hour.

Specific Start Hour
Task start hour is set to the specific value set in the Task Work Hour Start (Specific Time, 9:00
AM).

All work hour time values must be specified in Task Manager (Coordinated Universal Time, or
GMT/Greenwich Mean Time) when defining the task.

Holiday Offset Method
Extends or shifts a task duration if the task’s due date falls on a holiday.

Shift Task Start
Shifts a task’s start date to the holiday offset days set up in the holiday profile.
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Extend Task Duration
Extends a task’s duration to the holiday offset days set up in the holiday profile.

Note: Holidays occurring during the task duration do not affect the task start or due date
values.

Allow Private Task Groups
This setting controls access to the Task Administration page. Select this check box (default) to
allow all users access to the Task Administration page. If not selected, only members of the
Security Role group can access the page. Users who are not Administrators can only view Task
Groups they own.

Edit Commentary
Select this check box to allow a Commenter to edit their comments.

See also:

l Comments

l All Commentary

Close Dates
Close Dates associates a workflow (WF) time with a specific date and time. You can use this date
and time to determine if someone is late with their assignments, regardless of their geographic
location.
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Task Close Dates Pane
WF Time
The workflow time period. Click Add to add one record here for each workflow time period.

Close Start Day (Server Time)
Set this to the date when the financial close starts for this workflow time period. Server time is the
time zone where the OneStream Application Server is located.

Close Start Hour (Server Time)
Set this to the hour of day the close starts. Server time is the time zone where the OneStream
Application Server is located.

Close Date (UTC)
No entry required. Saving the record calculates this. The Close Start Day (Server Time) and
Close Start Hour (Server Time) values convert to UTC equivalents so you can compare the
current time a task is due to this entry to determine when it is due or late.
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Close Date (Day Map) Pane
Used if the Due Date MethodGlobal Option setting is set to Explicit Day Map List. You must
first create a task close date before creating a close date in the Day Map grid.

Work Day
Enter the work day for a close date. This can be any positive or negative numerical value.

Close Start Day (Server Time)
Set as the date when the financial close starts for this workflow time period. Server time is the time
zone where the OneStream Application Server is located.

Close Start Hour (Server Time)
Set as the hour of day for what time the close starts. Server time is the time zone where the
OneStream Application Server is located.

Close Date (UTC)
No entry required. Saving the record calculates the close date (UTC). The Close Start Day
(Server Time) and Close Start Hour (Server Time) values convert to their Task Manager
equivalent values to compare the current time a task is due to this entry to determine when it is
due or late.

Import, Export and Template for Close Dates
You can export a close date for manipulation and re-import. A template is provided as a
convenience with examples. You can import an Excel file with the close dates and associated
close day maps included for update or to be added as new. The following describes each button
and expectations.

Import
Click Import to choose the Excel file with the task close dates and associated close date day
maps to update or add. Any close date day map item requires that the related close date exists
before loading. Remove any sample rows before importing. You must close the Excel file, or an
error occurs.

Note: No data imports from the Excel file worksheets if the import process encounters an
error. The errors are written to a text file that is accessible in your File Explorer import folder.
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Export
Export manages exporting the selected task close date and any associated close date day map to
a CSV file to manipulate and import as an Excel file once named ranges are added. This extract is
not meant for creating new task close dates. To create new task close dates, use the provided
Excel import template.

See also: Template

To add named ranges:

1. Save the CSV file as an Excel XLSX file.

2. Create an Excel named range for close dates.

a. Select cell ranges starting with the cell containing Application to the last row in the
last column of data before the rows that start with Close Date Day Map.

b. Create an Excel named range that starts with the letters xft, for example
xftCloseDate.

3. Create an Excel named range for close date items.

a. Select cell ranges starting with the cell containing Application below Close Date
Day Map to the last row in the last data column.

b. Create a separate Excel named range for day map rows that start with the letters xft,
for example xftCloseDayMap.

4. After entering Excel data and defining named ranges, save the file and close it before
importing.

For examples and default values to use, refer to the How To tab in the example template by
selecting the Template button on the Close Dates page.

Template
OneStream provides an Excel template to import task close dates or close day maps. Use the
Close Date tab to enter updates to or add new close dates in the ranges between the blue lines.
Insert additional rows within this range to allow for more close dates. Remove sample rows before
importing.
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Close Dates Tab

Close Day Map Tab

Use the Close Day Map tab to enter updates to or add new close day maps in the ranges
between the blue lines. Insert additional rows within this range to allow for more close day maps.
This tab works from a different named range and both are imported.

The How To tab next to the Close Day Map tab explains how to use each field and gives
examples.

After entering data into the template, save and close the file before importing.

Delete All
Deletes all close date day maps from the selected close date.
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Categories
Administrators can maintain a list of up to three categories as informational labels for tasks. The
application loads with the initial category value of None for each. Add additional categories by
clicking Insert Row or importing them from an .xlsx file.

Note: There can be only one category named None.

Category 1, Category 2, Category 3
The list of categories maintained by your Task Manager Administrator and are used for
information labels for tasks.

Select Category 1, Category 2, or Category 3 to display the items in the category.
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Import and Export
Import
Click Import and select an .xlsx file. You can import to multiple categories at the same time. For
example, in this file, the Variance category is being added to Category 1, Category 2, and
Category 3.

You can update existing categories by using the same category name and changing the values in
the description and order fields.

You cannot have duplicate names within a category index. For example, this file is attempting to
create a category named Variance twice in the Category 1 index. This is not allowed.

Export
Click Export to export all categories to a .csv file.

Template
Click Template to use the template to create an import file.

Categories Buttons
The Task Categories pane on the Categories settings includes a toolbar that lets you add, update,
and delete categories.

Insert Row
Click to insert an additional row, then enter the category, description, and order.
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Delete Row
Select a row, then click . A row cannot be restored after it is deleted.

Note: You cannot delete a category if it is assigned to a task or has a published task
instance .

Cancel

If you've made changes, you can click to cancel all changes made since the last save.

Save

Click to save any changes made.

Category
The category’s name. Its value is required to save the category. You cannot create two categories
within the same category index with the same name. Special characters such as% are stripped
from the name. For example, EBIT and EBIT % are considered duplicate names. After saving, the
Category field is read-only.

Description
Text that displays when you configure tasks as the category.

Order
Controls the order in which categories display in a drop-down list box. The lowest number displays
first. If the order of each category is set as the same number, the list sorts by description.

Instructions
Administrators can upload files containing instructions that can then be assigned to all tasks in a
task group or to individual tasks. Instructions can be used to provide critical information needed to
process a task.
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Instructions files can use these file types:

l DOCX

l PDF

l PPTX

l RTF

l TXT

l XLSX

After instructions are assigned to tasks and published, you can view them in the Instructions pane
of a task. You cannot edit the instructions.

PPTX and RTF file types are not viewable from within the task’s Instructions section. When
these file types are used, Task Manager prompts you to download the file when you click the Task
Instructions icon for a task.

See also: Instructions (tasks with instructions only)

Note: Instructions can only be updated at the task level when adding or removing
instructions via mass update.
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File Name
Lists the file name and file extension of each instruction document currently used as a task
instruction.

Description
Any description added to the upload record of the instruction document.

User
The username of the person who uploaded the document.

Time Stamp (UTC)
The upload date and time for the listed document. This is determined by the time zone where your
OneStream Application Server is located.

Task Instructions Icon Bar
All menu bar selections display when you select a task instruction from the list.

Upload
Allows you to navigate to and select the instructions file you want to upload to include in the task
instructions list.

When uploading a task instructions file that contains restricted characters, the restricted
characters are removed from the file name when uploaded, resulting in a different file name. For
example, if you upload a file named &Instructions&.xslx, the file becomes
Instructions.xslx in the OneStream database because the restricted characters (the two
ampersands) are stripped from the file name. Because instructions file names must be unique in
the OneStream database, no other instructions file named Instructions.xslx can be
downloaded while that instructions file exists in the OneStream database.

See also: The Restricted Characters section of theOneStream Design and Reference Guide for
a list of restricted characters.

View
Select an instructions file, then click View to open the selected instructions file in the application
associated with the file type.
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Delete
Select a file to remove from the task instructions list, then click Delete to remove it from the list.
This does not permanently delete the file, but removes the file name from the OneStream
database.

Holiday Profiles
Administrators can maintain a list of holiday profiles that you can assign to tasks. Holiday profiles
group individual holidays into logical groups. For example, you can have holiday groups that
include all holidays for a specific country.

Holiday Profiles Pane
The Holiday Profiles pane lists currently defined holiday profiles and contains the following
information for each holiday.

Profile Name
The name assigned to the holiday profile.

Description
An explanation of what types of holidays are stored within the profile.
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Holiday Offsets Pane
These are the individual holidays that cause task due dates to be offset. Select the holiday profile
to which the holiday belongs, then click Insert Row in the Holiday Offsets pane to add a new
holiday. Offset task due dates allow additional time to complete and approve tasks when the due
date falls on a designated holiday date.

Holiday Date
The calendar date of the holiday. Click in the field, then select the Calendar icon. Switch to the
appropriate holiday date within the calendar to select it.

Note: You can also manually enter the date by selecting in the cell and typing in the holiday
date.

Offset (Days)
Enter the number of calendar days that the due date adjusts by when a task due date falls on a
specified holiday date. A positive number moves the due date to a later date, a negative number
moves the due date to an earlier date.

Description
The name of the holiday.

Holiday Profiles Icon Bar
You can export a holiday profile to manipulate and re-import. A template is provided as a
convenience with examples. You can also import an Excel file with holiday profiles and holiday
dates included, either to update or to add as new. The following describes each button and
expectations.

Import
Click Import to select the Excel file with the holiday profiles and associated holiday offsets you
want to update or add. Any holiday offset item requires that the related holiday profile exists
before loading. Remove any sample rows before importing. Make sure you close this Excel file
before importing, otherwise an error displays during the import.

See also: Import, Export and Template for Task Groups, Task Definitions and Task
Dependencies
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Note: Excel file worksheet data does not import if the import process encounters an error.
The errors are written to a text file stored in your File Explorer import folder.

Export
This manages exporting the selected holiday profile and any associated holiday offsets to a CSV
file to manipulate and import as an Excel file once you add named ranges. This extract does not
create new holiday profiles. To create new holiday profiles, use the provided Excel import
template.

To add named ranges:

1. Save the CSV file as an Excel XLSX file.

2. Create an Excel named range for holiday profiles:

a. Select the cell ranges starting with the cell containing Application to the last row in
the last column of data in the row before Holiday Profile Items.

b. Create an Excel named range that starts with the letters xft, for example
xftHolidayProfiles.

3. Create an Excel named range for holiday profile items:

a. Select the cell ranges starting with the cell containing Application below Holiday
Profile Items to the last row in the last column of data.

b. Create a separate Excel named range for holiday dates rows that starts with the
letters xft, for example xftHolidayDates.

4. After entering Excel data and creating named ranges, save the file and close it before
importing.

Template
OneStream provides an Excel template to import holiday profiles and holiday dates. Use the
Holiday Profiles tab to enter updates to or add new holiday profiles in the ranges between the
blue lines. Insert additional rows within this range to allow for more holiday profiles.
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Holiday Profiles Tab

Holiday Dates Tab

Use the Holiday Dates tab to enter updates to or add new holiday dates in the ranges between
the blue lines. Insert additional rows within this range to add more holiday dates. This tab works
from a different named range and both are imported.

You can update the offset integer for holiday date by clicking in the appropriate Offset cell and
entering a positive or negative whole integer. Once you fill out the template, save it and close the
file before importing. For examples and default values use, refer to the How To tab next to the
Holiday Dates tab.

Delete All
This lets you delete all holiday offsets for a selected holiday profile.
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User Preferences
Users can set their default start page, scorecard, task status sync type, and time zone on this
page.

Start Page
You can assign the default start page that displays when accessing Task Manager via OnePlace.
The start page options are: Task Analysis, Task Grid View, and Task Gantt View.

Simplified Scorecard
Select this check box to display the Simplified scorecard as the default scorecard to display.

See also: Scorecard
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Task Status Sync Type
Task status syncing is when the task preparation statuses for custom, workflow, and dependent
group task types are updated. When accessing Task Manager from OnePlace, all task statuses
update when you display the start page, including tasks that require syncing. The Task Status
Sync Type setting lets you determine when task status syncing occurs once the start page fully
loads.

Auto
Task status syncing occurs when:

l The Task Analysis, Task Grid View, or Task Gantt View pages load.

l Any of the menu bar task filters change.

l The Scorecard Task Detail dialog box closes.

Manual
Task status syncing only occurs when you click Sync Tasks and Refresh Page. Manual Task
Status Sync Type may be the preferred option when the Task Manager implementation includes
complex custom tasks.

User Time
The user’s time zone in which they work. This drives task due date information (Start Date, End
Date) and converts the task due date info to the user’s time on the scorecard pages.

Daylight Savings
Select the Daylight Savings check box to adjust tasks times to reflect the daylight savings offsets
for the selected user time over any given year. If this check box is not selected, then tasks times
do not adjust for daylight savings.

Note: It is highly recommended to set the User Time value to the same time zone as set on
the user’s Date & Time settings for Microsoft Windows. If the user time is different, tasks
reflect inaccurate times in certain grids and charts across Task Manager.
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Mass Updates
There are a few ways to reduce the maintenance that comes with editing properties on hundreds
of tasks. This is where mass updates are so useful. Use theMass Updates page to define
updates to apply. You can choose values to change in bulk, provide criteria for which items to
update, and preview changes. You also can apply the changes or restore the values to their state
before mass changes were made. Mass updates can apply to all tasks, whether published or
unpublished.

See also: Process Tasks in Bulk

1| Set Values to Update
The Set Values to Update pane is where you define the data change(s) to make.

Select the checkbox next to the fields you want to update, then specify the new value for each of
the columns that require updating. Updates occur on any row(s) matching the criteria established
in the Set Update Criteria pane.

2| Set Update Criteria and Process Update
Establish between one to three sets of criteria that identify the task rows changed by the mass
update. To establish the criteria, select the field and provide the value that identifies the tasks to
update.
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All listed criteria are considered together. An and query joins multiple criterion. Only rows
matching all the criteria change.

IfOperator is set to Contains and Value is set to a single apostrophe (‘), all records return, even
if there is only one row that contains a single apostrophe. Review the changes carefully before
applying.

Update Package Description
Assign a description to this update package before clicking Process.

Process - Process all updates for review.

Clear - Clears all the Values to Update and Update Criteria values.

3| Select Update Package & Apply, Restore, or Delete
The Update Packages pane is a list of description entries that you can later save to the task
records or delete the criteria. These criteria are visible only to you and can be called back up to
apply or restore in the future or delete.

Apply
If there are records present in Task Inventory (Mass Update Preview), click Apply to update
task inventory rows with these new properties.

Restore
If there are records present in Task Inventory (Mass Update Preview), click Restore to update
those task inventory rows with properties that existed before changes were saved.

Delete
Select a row in Update Packages and click Delete to remove this set of changes from the list.

Task Inventory (Mass Update Preview)
Task Inventory (Mass Update Preview) is a read-only preview of the changes you can make to
the task inventory when you click Apply. Carefully review the results of the value updates here.

XFDoc Add-Ins Settings
The XFDoc Add-Ins page lets you download the Microsoft PowerPoint and Microsoft Word XFDoc
Builder Add-Ins as a .zip file containing an Instructions file that walks you through the setup.

Task Manager Guide 28

Settings



Downloading the PowerPoint Add-In
1. Ensure Microsoft PowerPoint is closed. Click the PowerPoint icon in Task Manager XFDoc

Add-ins settings. The following Windows message is displayed.

2. ClickOpen.

3. Right-click to select the OneStream XFDoc Builder.ppam file and click Copy To.

4. Use the Windows Explorer Copy dialog box to navigate to the location specified in the
Installation Instructions (C:\Users\<UserName>\AppData\Roaming\Microsoft), where
<UserName> is the name assigned to you by the IT department to identify your username.

The AppData folder may be hidden by default. To unhide it in Windows Explorer, click
View, then select Hidden Items.
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5. ClickOK to select the location and close the Browse for Folder dialog box, then clickOK
to copy the file to the selected location.

Installing the PowerPoint Add-In
1. Open Microsoft PowerPoint and double-click Blank Presentation.

2. Click File>Options, and then click the Add-ins tab.

3. In theManage drop-down list at the bottom of the page, select PowerPoint Add-ins and
clickGo to open the Add-ins dialog box.

4. Click Add New and navigate to locate the file copied earlier. The OneStreamXFDoc
Builder.ppam file copied earlier displays.

Tip: Navigate to the C:\Users\<UserName>\AppData\Roaming\Microsoft\AddIns
folder if that is not the location of the folder.

5. Select the file and clickOK. OneStream XFDoc Builder now displays in the Add-ins as an
available add-in.

6. Click Close. The Add-ins window closes. The file is available from the Add-ins menu.

Downloading the Word Add-In
1. Click theWord icon in Task Manager XFDoc Add-ins settings. The following Windows

message is displayed.

2. ClickOpen.
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You can open the Word AddIn Installation Instructions.txt file for additional
information.

3. Right-click the OneStream XFDoc Builder.dotm file and select Copy To.

4. Use the Windows Explorer Copy dialog box to navigate to the location specified in the
Installation Instructions
(C:\Users\<UserName>\AppData\Roaming\Microsoft\Word\STARTUP), where
<UserName> is the username assigned to you by your IT department. If the STARTUP
folder is not visible, try closing Word before completing steps 1-6.

Tip: The STARTUP folder might be referred to by a different name depending on the
country in which OneStream is deployed.

5. ClickOK to select the location and close the Browse for Folder dialog box, then clickOK
to copy the file to the selected location.

Microsoft Word add-ins deploy as global macro enabled templates and do not require additional
add-in activation steps. If Microsoft Word is open during the copy, you must close the application
and re-open it to see the newly added item.

XFDoc Builder Overview
The OneStream XFDoc Builder Solution simplifies the extensible document creation process with
new Microsoft PowerPoint and Word Add-Ins. These XFDoc Builder Add-Ins are only for use
within Word and PowerPoint documents that are associated with tasks. They are not meant to
author Extensible Documents outside of Task Manager.

Note: An error message displays if the XFDoc Builder Add-In tools are attempted to be
used in PowerPoint and Word on documents created outside the Task Manager solution.

Using XFDoc Builder
Once you download and install XFDoc Builder Add-Ins (from Microsoft PowerPoint) and
templates (from Microsoft Word), use the XFDoc Builder solution to create OneStream Extensible
Document (XFDoc) in Task Manager.

See also:
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l MarketPlace Solution Modification Considerations

l Documentation Management for information on using the XFDoc Builder.
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Uninstall
You can uninstall the Task Manager User Interface or the entire solution. If performed as part of
an upgrade, any modifications performed on standard Task Manager objects are removed. There
are two uninstall options:

l Uninstall UI removes Task Manager, including related dashboards and business rules but
leaves the database and related tables in place. For some releases, you should perform
this step before accepting any new version of Task Manager since some of the Dashboards
or other objects may have been modified.

Choose this option if you want to accept a Task Manager update without removing data
tables.

The Task Manager Release Notes indicate if an overinstall is supported.

l Uninstall Full removes all related data tables, data, Task Manager Dashboards, and
Business Rules.

Choose this option to completely remove Task Manager or to perform an upgrade that is so
significant in its changes to the data tables that this method is required.

Caution: Uninstall procedures are irreversible.
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Task Manager Security
Once you enter Task Manager via the Task Manager dashboard profile, you can see certain
tasks. Task visibility and the ability to execute, complete, and approve is based on the setup and
ownership of the task group the task is assigned to, as well as the specific task attributes.

Security in Task Manager is split into the following:

l Design

o Task Manager Security

o Task Security

o Dashboard Security

l Runtime

o Segregation of Duties

Task Security
Users are created and added to groups using the System > Administration > Security screen.
Individual users or groups are selected as Preparers (task completers) and Approvers for each
task.

See Foundation in the Design and Reference Guide for more information on creating users and
user groups and assigning roles to users.

Dashboard Security
Default maintenance group security on the XFW Task Manager (UTM) Dashboard Maintenance
unit is set to Administrators. This should always be Administrators or another restrictive user
group to prevent unauthorized access and modification.

Segregation of Duties
Task Manager honors strict segregation of duties. If a person acting as a Preparer completes a
task in any given month, they cannot approve the same task that month.
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Task Administration
Click the Show Task Adminisration Page button in the Task Manager title bar. This is where
Administrators or any role set in the Security Role [Manage Task Setup] field of the Global
Options page can add and edit tasks, and perform other task processing.

See also: Security Role

Task Groups
To create task groups, click Insert Row in the Task Groups pane and enter information to create
each task group. Once this is completed, you can create and assign tasks. Task groups can stand
alone, but there is interdependency with tasks.
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Task Group
Text field describing the group of tasks.

Frequency
Shows the workflow time periods in which the group of tasks are required to be completed. If your
application has monthly periods, valid entries are 1-12 (every month) or 3,6,9,12 to only require
the task quarterly. If your application is configured for weekly periods, valid entries are 1-52 or any
subset (for example 20,40,52.

Important:When importing the task frequency value, add a space before ranges such as 1-
12 and 1-52, otherwise an incorrect frequency value displays in the task grid after importing
the file.

Owner
Determines who can view the tasks in the group. Select Public, Private, or User IDs from the
drop-down. Double-click in theOwner column of a task group and select an owner from the list.

Public
All users with access to Task Manager can see the tasks in the task group but can only process
tasks that they are assigned to.

Private
Filters task visibility in the task group to only Preparers and Approvers assigned to the tasks.
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User IDs
Only Administrators and the assigned user ID can view the tasks.

Instructions
Displays the name of the Instructions file added to the task. You can assign instructions to all
tasks in a task group or individual tasks.

Once you upload instructions using the Instructions page , you can select them in either the Task
Group Instructions or individual Task Instructions drop-down lists. By default, tasks inherit
instructions assigned at the task group level, but can also be assigned no instructions, None, or
assigned a different set of instructions. Once instructions are uploaded, assigned and their tasks
published, Preparers and Approvers can see the instructions within the task. Use the Instruction
page to upload and manage instructions.

Important: If you forward a task in a private task group to a user not assigned to that task
group, the new task owner cannot see the task and cannot complete it.

See also: Instructions

Note: For Instructions that use PPTX and RTF file types, you must open the file to view it.
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Task Groups Button Bar

Insert Row
Add a new task group.

Cancel
Removes changes made to the task groups since the last save.

Save
Saves new group(s) or updated task groups.

Column Settings
This lets you select the columns to display in the Task Groups and Tasks panes of the Task
Administration page.
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Select tasks in either the Visible Columns list or the Hidden Columns list and use the arrows to
move the selected tasks from one list to the other. You can hold down the SHIFT key to select
multiple sequential tasks, or you can hold down the CTRL key and select multiple non-sequential
tasks.

Then use the arrows to move the selected tasks from one list to the other. Use the Add All Items
or Remove All Items arrows to move all items from one list to the other.

The Visible Columns list shows the order in which columns display. To reorder a column in the
display, select the heading name from the Visible Columns list, then use theMove Up andMove
Down buttons to set where the selected column displays.

See also:Group Items that Display in Grids

Toggle
Changes the percentage of the page that displays the Task Groups pane.

Task Group Icon Bar

Publish
Opens the Publish Tasks dialog box. This lets you publish all the tasks for a specified time
period. Task groups and associated tasks are not visible to users until they are published.

Task Manager Guide 39

Task Administration



Start Time – End Time
The workflow periods to publish the selected task groups and task instances.

Publish Scope
This publishes the task instances for a selected task group or all task groups.

Publish Method
For the selected workflow period, both the merge and replace methods create any new tasks and
task groups. For previously published tasks and task groups, both methods also update any of the
task instance data edited. However, the replace method removes all task forwards and history,
and updates the task status to Not Started. The task comments persist.

The task comments, dependents, forwards, history, and status do not change when using the
merge method.

Copy
Opens the Copy Group dialog box. This lets you copy a task group and associated task
information to a new task.
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New Task Group
Enter a name for the new task group into which you want the selected task group and associated
tasks copied.

New Owner
Select an owner for the new task group from the list.

Preparer
Select a preparer for the new task group from the list.

Approver
Select an approver for the new task group from the list.

Delete
Deletes a task group and all associated tasks and published task history for that task group.

Deleting a task group displays a message asking if you want to delete the group and all published
task history, and displays the number of tasks, task instances, and number of time periods
impacted by the deletion of task historical items.
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Import, Export and Template for Task
Groups, Task Definitions and Task
Dependencies
You can export a task group and all associated task definitions to manipulate and re-import. A
template is provided as a convenience with examples. You can also import an Excel file with task
groups and/or task definitions included for update or adding as new. The following describes each
button and expectations.

Import
Use Import to select the Excel XLSX file with the task groups and task definitions you want to add
or update. Any task definition requires that the related task group exists before loading. Remove
any sample rows before importing. Close the Excel file on your computer, otherwise an error
occurs.

Note: Data from the Excel XLSX files worksheets does not import if the import process
encounters an error. Errors write to a text file that you can access in your File Explorer
import folder.

Clicking Import opens the Import dialog box, where you can import Excel file task data for use in
Task Manager.
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Export
The Export button exports the selected task group and all its associated task definitions to a CSV
file to manipulate and import as an Excel file after adding named ranges. This extract is not meant
for creating new task groups. Use the provided Excel import template to create new task groups.

To add named ranges:
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1. Save the CSV file as an Excel XLSX file.

2. Select the cell ranges starting with the cell containing Application to the last row in the last
column of application data.

3. Create an Excel named range that starts with the letters xft, for example xftTaskGroups.

4. For task list and task dependency rows, create separate Excel named ranges that start with
the letters xft, for example xftTaskList and xftTaskDependencies. This works if they are
different than the first named range.

5. Once you enter the Excel data and define named ranges, save the file and close it before
importing.

Click Template on the Task Administration page to see the How To tab in the example
template.

Excel Template
OneStream provides an Excel template used to import task groups, task lists, and task
dependencies. Use the Task Groups tab to enter updates to or add new task groups in the
ranges between the blue lines. Insert additional rows within this range to allow for more task
groups.

Excel Template - Task Groups Tab

To do this, include the named range for each task groups and task lists that start with the letters
xft.
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Excel Template - Task List Tab

Excel Template - Task Dependencies Tab

Use the Task List and Task Dependencies tabs to enter updates to or add new task definitions
in the ranges between the blue lines. Insert additional rows within this range to allow for more task
lists or task dependencies.

The How To tab next to the Dependencies tab explains the use of each field and give examples.

After entering data in the template, save it and close the file before importing.

Tasks
The Tasks pane on the Task Administration page lets you review and maintain tasks for a
selected task group.
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Tasks Pane Icon Bar

Add
Opens an empty Task Editor dialog box to create a new task.

See also:Task Editor

Delete
Select a task, then click Delete to delete the selected tasks. Confirm the deletion by clicking
Delete again.

Edit
Opens the Task Editor dialog box, which is pre-populated for the selected task.

See also: Task Editor
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Copy (Task)
Select a task, then click Copy to open the Copy Task dialog box, which you can use to copy the
selected task to a different task group or to the same group with a new task name.

New Task Name: You must provide a unique name for the new task.

New Task Description: Enter a description for the new task (optional).

New Task Group: Select a new task group from the list. For reference, the task group that the
task is being copied from displays at the top of the Copy Task dialog box.

Preparer, Approver: Use the list boxes for these to assign a preparer and approver to the
new task.

Depend
Opens the Dependent Task Manager dialog box for the selected task. Add or remove
dependencies for this task. You cannot complete this task until you complete its dependent tasks.

See also:

l Dependents (tasks with dependencies only)

l Dependent Task Manager

l Excel Template - Task Dependencies Tab
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Tasks Pane Button Bar
Cancel
Removes changes made to the task groups since the last save.

Save
Saves new group(s) or updated task groups.

Column Settings
This lets you select the columns to display in the Task Groups and Tasks panes of the Task
Administration page.

See also: Column Settings

Edit Task Information
Access the Task Editor from the Tasks Pane icon bar to add or edit tasks. Select a task and click
the Add or Edit icon and use the Task Editor to add or edit general information, scheduling and
action information, and to optionally add a conditional status expression.
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1| Info
Use the Info section of the Task Editor to add general information about the task. The description
you add in this section displays in the task’s details.
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Task Editor Info Field Definitions

1 | Info

Name The description that displays to users assigned to the task.

Notification

Configure when users are notified by email about task changes. Choices
are:

l None

l On Completion

l On Completion, Recall, and Rejection

l On Completion, Recall, Rejection, and Approval

l On Completion, Recall, Rejection, Approval, and Unapproval.

See also: Set up Task Notifications for more information about creating
notifications for upcoming due and past due notifications.

Preparer/Preparer
Group The Preparer or Preparer Group assigned to complete the task.

Approver/Approver
Group

The user or group assigned to approve the task once completed by the
Preparer.

Approvers can execute Doc Management, Open URL, and Open
Dashboard tasks for review prior to approving. All other task types require
Preparer rights when executing.

Tasks in public groups can only be executed by a Preparer or Approver.
Anyone can view the task.

Category 1,
Category 2 and
Category 3

The list of categories maintained by your Task Manager Administrator.
These categories are informational only.

Instructions

Select an instructions file from the list to use with the task or select the
default (From Group) to have the task inherit any instruction files from its
task group. Instruction files that display in the list have been uploaded and
included as instructions for a task.

See also:

l Instruction (tasks with instructions only)
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1 | Info

l Instructions Settings

Description Enter text describing the task. Administrators can use this field for quick
task identification and for understanding of what the task is about.

See also: Set up Descriptions to Identify Tasks

2| Schedule
The Schedule section of the Task Editor lets you set up task scheduling, timing, and priority.

Task Editor Schedule (UTC) Field Definitions

2 | Schedule

Work Day

Work Day is the number of days in relation to the period close date (0, +1, -1) (-1,
0, +1). All dates and times used for comparison are based on UTC (GMT) time
zone for consistency. This can be any valid positive or negative integer. Task
Manager validates the value as a valid positive or negative integer and displays a
message if the value is not an integer.

Start
Hour/Offset

The time on the Work Day in user time that the Task is due. All dates and times
used for comparison are based on UTC (GMT) time zone for consistency.

Duration The length of the task in hours or days.

Holiday
Profile Select a Holiday Profile to assign to this task to offset dates.

Frequency

Frequency is the workflow time-period in which the task takes place. The
frequency inherits from the task group. The task has the same frequency set on
the task group if the task frequency is left empty. If modified, it shows at a filtered
frequency from the task group.

For example, if the group is 1-12 and the task is set to 3,6,9, or 12, then the task
only shows quarterly.
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2 | Schedule

You can only see frequencies listed in the owning task group. If a frequency not
listed in the task group is used, the period referenced is ignored.

Priority An informational indicator to users that allows them to prioritize their work. Valid
options are High, Medium and Low.

Is Milestone When set to Yes, Is Milestone adds a diamond shape to the Gantt chart
indicating major progress points needing to be met for success of the task group.

3| Action
The Action section of the Task Editor is where you determine the task’s action type. The selected
task’s action type determines the additional fields used to define how the task executes.

Task Editor Schedule(UTC) Field Definitions

3 | Action

Action
Type

Action Type indicates the type of task to complete. One or more additional fields can
display based on the Action Type selected. Select the appropriate information display
in these fields to support the selected Action Type.

See also: Task Action Types for information on additional information needed for each
task action type.

Any security in place for each of these actions remains in effect. For example, if
creating a task that sends a user to a dashboard for which they do not have access,
they do not see any of the dashboard components.
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3 | Action

Status and approval updates for tasks with certain Action Types happen automatically
when taking associated actions in OneStream. Other tasks must have status and
approval values updated manually.

4| Status
Use the Status section of the Task Editor to define any conditions required for the task.

Conditional Status Expression
This lets you create situational overrides for task dependencies. Create an XFBR business rule
that specifies what condition needs to be met and include the conditional statement in the field.

Note: XFBR is a script that you or the Administrator must create.

In the previous example,MyBRStringRule is the business rule name andMyBRStringFunction
is the function name.

Note: This conditional statement points to a custom XFBR business rule to suit the
conditional requirements. You can include additional rule arguments.

If the condition is met (success), nothing returns, and the associated task completes. If not met
(failure), the condition returns a string, and the custom statement displays in the business rule.
Include in this custom statement an explanation of why the task is running and the message to
display upon failure.

Conditional status is not meant to override task dependents. It is meant to add external
restrictions (for example, test if GL is closed before allowing workflow completion).

See documentation on XFBR Business Rules in the Design and Reference Guide for more
information.
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Action Types
This section details each task action type and the additional information needed to define the
task’s action.

No Action
Used as a reminder, typically something done outside of OneStream. No additional fields
requiring completion display when selecting this option.

Custom Task
Custom task lets you create the relationship between a task definition and a custom dashboard.
An available option includes a function to automatically update a related task’s status upon
reviewing the Task Analysis, Task Grid View, or Task Gantt View page where this task is
listed.

Executing a custom task opens the custom dashboard in a separate Task Manager tab, so you
can easily switch between the dashboard tab and the tab containing the task’s details.

The following example shows a configuration for this type of task action. The example dashboard
and CTK_ParamHelper rule shown are not included with Task Manager, but are shown here for
illustrating what is possible.
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Dashboard
Choose a dashboard list that displays relevant information. The previous example is simplified to
show a dashboard displaying a Label dashboard component. You can use any dashboard
component, such as running a report, cube view, custom table viewer, or URL.

Task Parameters
Specified task parameters pass to the dashboard or auto-status function. In the previous
example, the task looks up the name currently logged in to display in a label on the dashboard.
Syntax is to list the parameter name passed and its value.

ExternalName=Current User Name is |UserName|

A caret (^) shown in the Task Action view is not required but is added by OneStream just to
display in the form. Task Manager removes it upon saving. In this case, it replaces the pipe
characters in |UserName| so OneStream does not do a lookup while rendering the form.

The example Label calls another XFBR rule and passes these task parameters (such as
ExternalName in this case) as an input. This returns as Current User Is Administrator in this
case.

Auto-Status Function
OneStream calls this function when you open any of the Task Analysis, Task Grid View or Task
Gantt View pages and updates the custom task’s status.

XFBR(CTK_ParamHelper, GetTaskStatus, TaskName=TestTask)

The caret character (^) shown in the Task Action view (for example XF^BR) is not required.
OneStream adds it just to display in the form and removes it upon saving. No user interaction is
required.

You can optionally use the TaskName argument if the resulting auto-status function needs the
task name (or some other passed-in argument) to obtain the proper task status.

This XFBR function (calledGetTaskStatus in the example) returns a string of a status message
as a string back to Task Manager, which applies the update. Options are:
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l NotStarted

l Inprocess

l Inprocess_## (where ## is a percent complete)

l Completed

l Rejected

This example shows how you can configure this dashboard XFBR String business rule. The Task
Manager Administrator must create this rule and varies in its use in each implementation.

If you select Complete on the task, Task Manager updates the percent complete and the status.
However, if the status returns Completed when you rerun the custom task, the system sets it to be
equal to what the auto-status function returns.
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Data Mgmt
Allows you to run a specific data management sequence. This lets you execute a predefined task
in Task Manager that you would normally not be able to access and execute within OneStream.

Data Mgmt Sequence
For the Data Mgmt action type, chose a data management sequence from the drop-down list and
select whether the sequence automatically executes.

Note: Data Management tasks do not process notifications as they auto complete. The
selected DataMgmt job must use a BR to send completion notifications.

Auto Execute
If set to No, the Preparer must execute the task. Task Manager updates the task status to
Complete. The Approver must still approve the task.

If set to Yes and the task has no predecessor tasks, the task runs when the Preparer accesses it.
The Status and Approval values automatically update.

Dependent Group
Tasks can be made dependent on all tasks in a task group. You can set his dependency using the
action type of Dependent Group within a task definition.

Task dependencies can be applied by three different methods:

l Completing specific task(s) in a task group

l To all tasks in a task group (dependent group)

l Via a conditional status filter expression
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Group Name
The task groups that are available. You must also update the task group name in the Action
parameter on the Task Administration page if changing the task group name for any dependent
group.

Dependency Type
You can apply the dependency to all tasks or filtered tasks. If selecting filtered tasks, the filter
expression can be used to filter the tasks for the dependent group.

Filter Expression
Change dependency type to Filtered Tasks and click Build to open the Filter Expression
Builder dialog box. This lets you create an expression to meet the dependency requirement.
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The Filter Expression Builder dialog box lets you build custom filters across:

l Task Names

l Action Types

l Work Day

l Start Hour

l Duration Hours

l Priority Types

l Notification Types

l Categories

l Milestones

Operators include And, and Or, as well as, =, >=, <=, <>, = > <.
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Click Close to write the filter expression back to the task action properties.

Dependent group action type tasks do not change to Completed until all the underlying
dependent tasks complete. The approval status is Unapproved by default and changes to Not
Required when an underlying dependent task status is changed.

See also: Filter Items that Display in a Grid

Doc Mgmt
This type of task opens the Document Management toolbar when executing the task.

See also: Document Management

Open Dashboard
Directs users to a specific dashboard in OneStream. Executing an Open Dashboard task opens
the dashboard in a separate Task Manager tab, so you can easily switch between the dashboard
tab and the tab containing the task’s details.

Dashboard
Choose a dashboard from the list.

Open Page
Directs users to a page in OneStream , such as the FxRates page.
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Page
Select the OneStream application page.

Open URL
Directs you to the specified website.

Website URL
Provide the target URL. Ensure that the Preparer has access any specified internal or secure site.

Note: Some websites do not allow dashboard rendering and forces opening the dashboard
in a full screen. This can cause the OneStream page to navigate away from OneStream
instead of allowing the website to open in a new window. OneStream cannot control this
behavior. An error message may display in this situation.

Open Workflow
Directs users to open the specified workflow for the selected scenario and workflow time.
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Workflow Profile
Select the workflow profile to use. The list box values are based on the Preparer security defined
in Section 1 –Info.

See also: 1 | Info

Workflow Scenario
Select the workflow scenario to use. The list box allows piped parameters such as |POVScenario|
as well as a list of scenarios in OneStream .

Workflow Time
Select the workflow time to use. The list box allows piped parameters such as |WFTime| as well
as a list of workflow time periods in OneStream.

Select the drop-down list box arrow to select the required profile, scenario and workflow time.

This task cannot be marked completed until the related workflow is marked completed (a check
mark indicates completion). Also, workflow tasks are not marked completed even if the workflow
is manually completed until all prior tasks have also been marked complete.

Set up Task Notifications
The OneStream Task Scheduler includes two sequences you can use to set up automatic email
notifications for tasks. A sequence is an ordered series of one or more steps that execute in the
order in which the steps are organized.

When you install Task Manager, two sequences related to task notification emails are added to
the Platform Task Scheduler. The UpcomingTaskNotifications_UTM sequence manages
notification emails for tasks coming due within a specified number of days. The
PastDueTaskNotifications_UTM sequence manages when notification emails are sent for tasks
that are past due.

Note: The OneStream Task Scheduler is only available in the OneStreamWindows
application. OneStream encourages using the Windows application upon upgrade.

These sequences include default parameters and default values for the parameters. The
sequences are defined in the OneStream Data Management module, in the Task Manager Data
Management Group. In OneStream, click Application > Tools > Data Management to display
the Data Management pane. Then in the Data Management pane, click Data Management
Groups > Task Manager > Sequences to see the predefined sequences and their properties.
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See also: The Data Management section in theOneStream Design and Reference Guide for
more information about the Data Manager and Data Management groups and sequences.

Create a Task and Add the Task Manager Sequences
Note: As part of the Data Management job within Task Scheduler, first run the Task
Manager process to ensure all tasks are updated and synchronized to properly calculate
what is upcoming or past due.

1. In OneStream, click Application > Task Scheduler to open the Task Scheduler. The Task
Scheduler Grid View displays the current list of scheduled tasks.

2. Click the Create Scheduled Tasks button to open the New Taskdialog box, where you
can add information about the new task and schedule the notification emails.
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3. In the Task tab, enter a name for the new task in the Name field.

4. The Start Date/Time field shows the time the task was created. This defaults to the current
date and time. You can change this if necessary.

5. In the Data Management groups tree view below the Sequences field, navigate to and
expand the Task Manager (UTM) Data Management group to display the
PastDueTaskNotifications_UTM and UpcomingTaskNotifications_UTM sequences.

6. Click on each of the sequences under the Task Manager (UTM) Data Management group
to see the preset parameters and their values. If necessary, you can edit these values.

The following table describes the parameters for both Task Manager sequences and their
default values.

Parameter Description

WFTimeName

Workflow time name. This specifies the time function to be
used when calculating tasks that are upcoming or are due. The
default value is |GlobalTime|, which references the Global POV
time.
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Parameter Description
See also: Time Functions and General References in the
OneStream Design and Reference Guide for more information
on various time functions that can be used as values for this
parameter.

TaskGroupName

The name of the Task Manager task group containing the tasks
to execute the sequence against. The default value is (All)
which specifies that all task groups are checked to see if this
sequence applies to any of the group's tasks.

The Task Scheduler does not validate this parameter's value. If
specifying a single task group, ensure the value exactly
matches the task group name.

DaysPastDueMax
(PastDueTaskNotifications_
UTM sequence)

Represents the maximum number of days past the task's due
date in which past due notifications are generated for the task.
The default value is 30, which indicates that tasks up to 30 days
past due generate past due notifications according to the task's
schedule.

DaysPastDueMin
(PastDueTaskNotifications_
UTM sequence)

Represents the minimum number of days past the task's due
date in which past due notifications are generated for the task.
The default value is 1, which indicates that tasks one day past
due generate past due notifications according to the task's
schedule.

DaysPastDueMin works with DaysPastDueMax to define the
range of days for a task to be considered past due for
generating past due notifications.

So for example if DaysPastDueMin is 1 and DaysPastDueMax
is 30, then tasks that include this sequence would start to
generate past due notifications one day after the task's due
date, and continue to generate past due notifications until the
task is 30 days past due.

DaysUntilDueMax
(UpcomingTask Notifications_
UTM sequence)

Represents the maximum number of days until the task is due
in which upcoming due notifications are generated for the task.
The default value is 3, which indicates that tasks up to three
days until the task's due date generate upcoming due
notifications according to the task's schedule.
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Parameter Description

DaysUntilDueMin
(UpcomingTask Notifications_
UTM sequence)

Represents the minimum number of days until the task's due
date in which upcoming due notifications are generated for the
task. The default value is 0, which indicates that tasks up to the
day of their due date generate upcoming due notifications
according to the task's schedule.

DaysUntilDueMax works with DaysUntilDueMin to define the
range of days for a task to be considered upcoming due for
generating upcoming due notifications.

So for example if DaysUntilDueMin is 0 and DaysUntilDue is 3,
then tasks that include this sequence would start to generate
upcoming due notifications starting three days before the task's
due date, and continue to generate upcoming due notifications
until the task is due.

Note: For the DayPastDueMax/Min and DaysUntilDue Max/Min settings, timings are
calculated based on the time zone of the user who creates the data management job that
uses the Task Manager sequences.

7. Click on a sequence, then click the Schedule tab and use the radio buttons to specify the
frequency and recurrence of the task's execution.

8. ClickOK to save the new task and its schedule and include the Task Manager (UTM)
sequences.

The Task Manager Grid View reflects the days until and days past settings for each task in the
Days Until and Days Late columns.
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In this example, if Days Until is 0 and Days late is 0 for a task, then notifications are set for tasks
due today. If days until is 1, that means the tasks for the sequence are due tomorrow. Days until
indicates when upcoming due notifications occur, and days late indicates when past due
notifications occur.

Notification Emails
Upcoming email notifications are sent to the current preparer if the preparer is a current user and
has a valid email address defined in OneStream. The current preparer for each task shows in the
Preparer column of the Task Grid View. If the task preparer is (Unassigned), the email is sent to
everyone in the preparer group. The current preparer can forward the email as necessary. Past
due task notifications are sent to the preparer and approver. If the task approver is (Unassigned),
the email is sent to everyone in the approver group.

Email recipients only get one notification per day for all tasks that meet the notification
parameters. The email shows every task that they are the preparer or approver of that meets the
notification criteria. You can set up past due and upcoming due notifications at the same time
within the same job. Notification emails are sent from the OneStream OSUser address
(OSUser@onestreamsoftware.com).

For both upcoming due and past due notifications, the email shows the time period in the email
subject line. Tasks listed in the email are grouped in alphabetical order by task group.

The email for notification for past due tasks contains the word Urgent in the subject line. The
email notification for upcoming due tasks contains the wordWarning in the subject line.

Both upcoming due and past due email notifications list the following for each task:

l Task Group Name

l Task name and task priority

l Days Until Due (upcoming tasks)/Days Past Due (past due tasks)

l Preparer and Preparer Group

l Approver and Approver Group

Manage Dependent Tasks
You can select a task and define dependencies with other tasks in the same task group.
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Task Manager does not prevent creating task dependencies out of date order. For example, a
task that must be started on Day 2 can be created as a dependent of a task that ends on Day 4.

1. In the Task Administration page, select the task that requires a dependency association.

2. Click Depend to open the Dependent Task Manager dialog box.

3. Select the task you want to be a dependent from the Available Tasks column.

4. Click Add to move the selected task to the Dependent Tasks column.

5. Repeat steps 3 and 4 as needed to add additional task dependencies to this task.

6. Click Close when all dependencies have been added.

You can also select a task and click Remove if you enter a task as a dependent in error. This
moves the selected task back to the Available Tasks column.

Note: Tasks having dependences cannot be set as completed without all its dependent
tasks being marked as completed first.

See also: Tasks Pane - Task List Menu Bar
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Switch Between Task Analysis and
Scorecard Pages
Task Analysis displays Scorecard and Task Analysis pages to view task data across various
charts and grids. Additional Scorecard and Analysis icons in the Task Filtermenu bar let you
easily switch between Scorecard and Analysis pages.

Task Filter Menu Bar
Task Filter menu bar items display on the Task Analysis, Task Grid View and Task Gantt View
pages, as well as the Scorecard and Analysis pages. Scorecard and Analysis pages also
display any applied filters that update the tasks presented in the charts, grids, and counts for each
page. Navigating between the different pages in Task Manager automatically saves the filters.

Time
A list of monthly time periods. Select the time period for which you want to display tasks.

Group
A list of published task groups.

Role
A list of task ownership by role. Filter results by:

l All

l Preparer

l Preparer/Preparer Group
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l Approver

l Approver/Approver Group.

The Preparer/Preparer Group displays any tasks assigned to someone who is the sole Preparer,
or as part of the Preparer group. The same behavior applies when selecting the
Approver/Approver group.

User– (As Admin only)
Lists users that have access to Task Manager. Only Task Manager Administrators can access
this filter when the View Type is set to As Admin.

Category Filters
Three lists of Category 1, Category 2 and Category 3 for filtering. Any combination of these is
considered the intersection of these categories (an AND combination) and not the superset of
categories that meet each specific entry (anOR combination).

Task Manager limits the Category filter results to the categories assigned to tasks the user has
access to. The Category filters reset to All when changing the task group filter.

Refresh
Selecting Refresh synchronizes all custom, workflow, and dependent group task action types and
refreshes all task charts, grids, statuses, and counts.

View Type
For Administrators, this drop down lets users switch between Administrator View and viewing as a
user - only seeing what is assigned to them. This filter is only visible to Task Manager
Administrators.

(Additional Task Information)
The Task Filter Menu for Scorecard and Analysis views, as well as the Task Manager Grid and
Gantt views, display the following information that applies to all filtered tasks:

Tasks
The count of total filtered tasks for the selected time period.

% Completed
The percentage of the total filtered tasks completed for the selected time period.
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Past Due
The count of total filtered past due tasks for the selected time period.

Scorecard
The Scorecard provide charts that let you know immediately where tasks are in the preparation
and approval process. All charts in the different Scorecard pages (As User view, As Admin view,
and Simplified view) have drill down capabilities. Click on any chart bar, node or pie area to drill
down and display the associated tasks in the Task Details dialog box. Task statuses derive from
the User’s Time set on the User Preferences page.

Scorecard – As User View

See also:

l User Preferences

l Task Status Sync Type

The Scorecard - As User View page gives you a quick look into the status of tasks that display
on the page based on the defined filter criteria. It also shows tasks with comments made by other
users.
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Overall, this page provides a one-stop overview of where your tasks stand in terms of their
completion status, and which tasks are becoming due.

Each bar in the charts on this page show the number of items within the bar itself (unless there are
zero items). You can also hover over any bar in the charts to display a pop-up showing the
number of items. Click any bar on any of the charts to display and process its tasks using the Task
Details dialog box.

Preparation Status
This chart uses horizontal bars that represent the total filtered task count by each preparation
status – Completed, Rejected, In Process, and Not Started.

Approval Status
This chart uses horizontal bars that represent the total filtered task count by each approval status
– Approved, Unapproved, and Approval Not Required.

Due Date Summary
This chart uses vertical bars that represent the total filtered task count by past due, due today, or
due within one to five days.

Work Day Summary
This chart uses vertical bars that represent the number of filtered tasks across the workdays for
the selected time period. Selecting one of the columns displays the tasks for that workday in the
Task Details dialog box. You can also hover over any bar in the chart to display the number of
tasks belonging to each preparation status in a pop-up.

Comments by Others
This grid shows when you apply the As User filter. All comments made by other users to assigned
tasks display in this grid. This grid works as a pivot chart, so you can drag and drop columns to
creating grouping.

Like other grids with columns in Task Manager, you can group comments by any column or
column combination.

See also:Group Tasks that Display in Grids

Scorecard – As Admin view
The As Admin scorecard displays the Timeliness Trend chart along with the charts presented on
the As User scorecard.
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Timeliness Trend
This shows the total number of past due and on-time tasks for the selected time period over a
trailing twelve-month period. Selecting one of the nodes opens the respective Task Details dialog
box.

Scorecard – Simplified view
The Simplified scorecard view is an alternative view that optionally displays when you select the
Simplified Scorecard setting on the User Preferences page.

See also: User Preferences
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Tasks by Priority
This pane displays a pie chart that represents the percentage of High, Medium and Low priority
tasks. Hover over a section of the pie chart to see the number of tasks for the highlighted priority
type.

Click a section of the pie chart to display and work with tasks for the selected priority in the Task
Details dialog box.

Tasks Coming Due
Displays a bar chart that shows the number of tasks due in each of the next five days, as well as
the number of tasks due today and number of tasks past due. Hover over a section of the chart to
see the number of tasks for the highlighted priority type.

Click a section of the pie chart to display tasks for the selected priority in the Task Details dialog
box.

Tasks by Status
This displays a bar chart that represents the number of Completed, Rejected, In Process, and Not
Started tasks. Hover over a section of the chart to see the number of tasks for the highlighted
priority type.

Click a section of the pie chart to display tasks for the selected status in the Task Details dialog
box.

See also: Task Details
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Analyze Tasks
The Analysis page includes Explorer Pivot and All Commentary grids. You can reorder grids in
the Explorer Pivot and All Commentary pages.

See also: Reorder Grid Columns

Explorer Pivot
A filtered grid of task data that can be pivoted by dragging a column header into the blue bar
above it. Filter data by selecting the filter symbol on each column header.

See also: Reorder and Filter Grid Items Columns

The grid data can be exported to Excel XML, CSV, Text, or HTML. Right-click anywhere on the
grid and select Export, and then select the data export type.

Timeliness Trend (As User only)
This provides the total number of on-time and late tasks for the selected time period over the
trailing twelve months. Click on a node to open the Task Details dialog box with the filtered task
list.
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All Commentary
Provides all task comments by task name, group name, commenter, and time stamp.

Task Details
Select any task or chart item in the charts to open the Task Details dialog box and display the
available task details for the selected task or chart item. Click on any column heading in the task
list to sort the tasks by that column.

See also: Group Tasks Using Column Headers
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Refresh Task Status
Click Refresh to update all task statuses in the Task Details dialog box, excluding tasks that
require syncing.

Select Tasks to Process
The leftmost column in the Task Details pane contains check boxes that let you select a single
task or multiple tasks to process. You can select multiple tasks and perform mass actions to the
selected tasks.

See also: Process Tasks in Bulk

Clicking anywhere in a task row selects that task and displays the task details. Click the check box
in the column header to select all tasks.

Task Status Indicator
Each task’s status icon in the Status column reflects the task’s current state.
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Not Started
An empty circle icon indicates that no progress has been made on the task.

Blocked by Dependent
An orange circle icon indicates that the task is blocked because a dependent task is open.

In Process
A blue circle icon indicates that the task is in process.

Rejected
A red circle icon indicates that task approval is rejected. You must complete the task again and
resubmit it for approval.

Completed
A green circle icon indicates that the task has been completed and is awaiting approval.

Fully Approved
A green checkmark icon indicates a completed and approved task. This includes tasks where
approval is not required.

Task Action Menu Bar

The Task Actionmenu bar includes the following buttons which display in context depending on
the type of task, its status, and the data about the task.

Icons in the Task Actionmenu bar display in green to indicate that the selected task includes
items represented by the icon. For example, the task shown in the Task Actionmenu bar above
(Cash Plan) includes dependents and instructions.

Details
Selecting this provides task details such as assignment by Preparers, Approvers, and Preparer
and Approver groups, action type, action parameters, and history.

Comments
Click Comments to display the Comments pane, where you can review, add, and edit comments
and share additional information about the task. Any user can edit their own comments.
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Click Insert Row to add a comment, then click Save. If needed, click Cancel to revert any
unsaved edits. Commenter and Time Stamp (UTC) column values default to the current user
and time and cannot be edited once saved.

Preparers can only add comments to tasks to which they are assigned and have a status of Not
Started or In Process. Approvers can add comments to tasks of any status.

Administrators and Approvers can edit their own comments until the task is Approved. Preparers
can edit their own comments until the task is Completed.

You can edit your own comments, but you cannot update another user’s comments. To edit a
comment you added, select the comment in the Task Commentary pane, click in the comment
field to edit, and then click Save. The time stamp on the comment updates to reflect the latest edit
time.

Attachments
Use attachments to communicate and share additional information needed by those working on
the task. Use attachments to associate all supporting documents needed to properly process the
task. Task Manager supports a wide range of file types that you can attach to a task. Preparers,
Approvers, and Administrators can add an attachment to a task.

Note: All file types except XML can be used as attachments. There are no size limits,
though extremely large files may time out during the attachment process.

Click the Attachments icon to display the Attachments and Attachment History panes.

The Attachments pane lists current attachments for the task and lets you upload additional
attachments or view and delete attachments for the selected task. Any files that have been
attached to the task display in the grid.

The Attachment History pane lists any attachments that are part of the task’s history.
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You can only add attachments to tasks that have not been completed.

Attachments Menu Bar

You can perform the following actions on task attachments when you select an attachment in the
Attachments list for a task.

Upload
OpensWindows File Explorer so you can navigate to and select a file to upload as a task
attachment.

View
Opens the selected attachment in its native application so you can review and update the
attachment’s contents.

You can also view an attachment in the task’s attachment history. In the Attachment History
pane, select the attachment and click the View icon that displays at the bottom of the pane. The
attachment opens in its native application.

You make changes to an attached file you are viewing from the Attachment History pane, then
save the updates and upload and attach it to the same task instance, a different task instance, or
any other task. This is useful for instance when you have a document whose data changes on a
monthly basis. You can select the current task, select the attachment with the document in the
Attachment History pane, make changes, then upload the changed document as an attachment
to the current task instance.
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Delete
Select an attachment in the Attachments pane, then click Delete to remove it from the list of
attachments associated with the selected task.

Dependents (tasks with dependencies only)
Click Dependents to display any dependent tasks that exist for the selected task. Define task
dependencies for a task using the Dependent Task Manager.

See also: Dependent Task Manager

Two different views of dependent tasks display.

The left pane displays the entire hierarchy of the selected task’s dependents in a tree view. Use
the Dependent Tasks tree view for a quick overview of the relations between a task’s
dependencies and to understand the levels of the dependent task parent/child hierarchy. The tree
view shows all levels of nested dependency for the selected task.

The right pane lists each dependent task in a grid view.

These views allow you to assess the status of each dependent task and provide information about
when the dependent task is due and to whom the dependent task is assigned.

Like the Status column of the Dependent Tasks grid, icons shown next to each dependent task in
the tree view indicate the dependent task’s current status. In the following image, all dependent
tasks show a green check, indicating all dependent tasks are complete.

See also: Task Status Indicator
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You can send an inquiry message directly from this page to the selected dependent task’s
Preparer. This lets you easily collaborate and share information about the task. To send an inquiry
message, select the task, then enter your message in the Inquiry field. Click Send to send the
message to the task Preparer.

The Dependents icon displays in green in the Task Action bar for tasks that have dependent
tasks.

Note: Tasks with incomplete dependent tasks cannot be approved.

Instructions (tasks with instructions only)
Instructions can be assigned to tasks. You can view any assigned instructions in the Task

Instruction viewer. Click to expand the Instruction viewer to the OneStream window size or
size as needed.

See also: Instructions

Forward
This icon displays if you have the right to forward the selected task. Forward lets Preparers and
Approvers reassign task instance ownership to a different Preparer or Approver in the selected
time-period. Task forwarding does not change the task assignment for past or future time-periods.
Preparer Group and Approver Group assignments are retained.
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Forward lists are not based on security access. If you forward a task to someone who does not
have security access to the underlying action, they cannot complete their action. You can filter the
lists by typing into the filter text box.

When a task is forwarded to a new Preparer or Approver:

l The task displays in the new Preparer’s or Approver’s queue.

l The new Preparer or Approver receives an email notification.

l There is an entry logged into the Task Detail History table.

l An orange circle displays in the Preparer Fwd or Approver Fwd column in the task grids
for the selected time-period.

Task status action buttons (Started, Not Started, Complete)
Click Start to move the selected task’s status to In Process. Click Complete to move the
selected task’s status to Completed.

Execute
This button executes the task action for the selected task. Executed task actions differ based on
the Task action type.

See also: Execute Tasks for details on executing tasks based on task action type.

Execute is available for all users assigned as the Preparer of a task and all tasks types.
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Note: The Execute button is hidden for tasks with the No Action task action type.

Execute Tasks
When you execute a task, the action taken to execute the task is based on the action type of the
task.

Execute a Custom Task
Tasks with a Custom task action type display a dashboard in a separate tab when you click
Execute, so you can easily switch between the dashboard tab and the tab containing the task’s
details. Navigation and actions can be taken in the Task Manager dashboard.

Execute a Data Management Task
Tasks with a Data Mgmt task action type run a data management sequence in the background
when you click Execute. The OneStream Task Activity log reflects updated data management
sequence status.

Execute a Dependent Group Task
Tasks with a Dependent Group task action type show a Gantt view of the dependent group and
its tasks when you click Execute.

Click the ellipsis in the Details column to display a dependent task’s details in the same area. This
is helpful to see the dependent task details and take any actions on that task without having to
navigate away from the page.
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The preceding example shows the original task Disclosures executed, and the dependent task
Shareholder Letter is selected from the Gantt view to display in the page. You can also see any
cascading dependent tasks on the same page.

Execute a Document Management Task
Tasks with a Document Mgmt task action type display the Document Management menu bar
when you click Execute.

See also: Document Management Tasks
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Execute an Open Dashboard Task
The OneStream dashboard displays in Task Manager tab when you click Execute, so you can
easily switch between the dashboard tab and the tab containing the task’s details. Navigation and
actions can be taken in the dashboard in Task Manager.

Execute an Open Page Task
Tasks with anOpen Page task action type open a specified OneStream page in a separate tab
when you click Execute.

Executing an Open URL Task
Tasks with anOpen URL task action type display the website in the task when you click Execute.
You can navigate and perform actions across the website in Task Manager.
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Executing an Open Workflow Task
Tasks with anOpen Workflow task action type open the specified workflow in a separate tab
when you click Execute.

Task Status Actions
Preparers and Approvers have different task status actions that are available depending on the
task state.

Task Manager Administrators can also access these actions for their own tasks or a Preparer or
Approver’s tasks when you select the As Admin filter. However, Segregation of Duties are
enforced so that anyone acting as a Preparer who completes a task in any given month cannot
approve the same task that month even if they are a Task Manager Administrator. Only actions
specific to the current task status display.

Preparer Status Actions
Start
Sets the task status to In Process.

Complete
Sets the task status to Completed.

Not Started
Sets the task status to Not Started.

Recall
Sets a completed task to In Process.

Approver Status Actions
Approve
Sets the task status to Approved.

Reject
Sets the task status to Rejected.

Unapprove
Reverts an approved task status back to Completed.
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See also:

l Task Manager State Diagram in Appendix A for the different task states and task status
actions available for preparers and approvers.

l Process Tasks in Bulk for information on bulk processing task status actions on tasks.

Status
The Task Action bar shows the task’s progress. Task Preparers and Approvers can complete
and approve directly from Task Action bar.

Tasks with the OpenWorkflow action type are linked to actions taken in OneStream. The Status
and Approval values for these tasks automatically update as the related actions are completed in
OneStream.

% Complete
The task completion percentage for the selected time period.

Approval
The task approval status of Approved, Unapproved, or Not Required.

Set up Task Descriptions
Administrators can add descriptive text for a task. Use the Task Editor or the Description field in
the Task Administration task list to enter description for a task. Click in the description field of the
task to enter the description.

Task descriptions are a useful way for Administrators to quickly assess the nature of the task and
lets you communicate what must be done to work on or complete the task.

Descriptions can only be entered by Administrators. After the task is published, task Preparers
and Approvers can view descriptions, but cannot add or edit descriptions.

The following image shows the Description field in the Task Administration task list.
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The default column ordering in Task Manager places the Description field in the Task List as the
second rightmost column. You can click Column Settings in the task list and use the Column
Settings dialog box to move the Description field to where it can be viewed without scrolling the
task list to the right to see the field in its default column ordering location.

See also: Column Settings

The following image shows the Description field in the Task Editor. You can use either the Task
Editor or Task Administration task list to enter descriptions for tasks that you manually add.
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Task descriptions display in the Task Details pane of the Task Grid View and Task Gantt View
pages, so you can quickly assess the nature of the task. However, you cannot edit the
descriptions in the Task Details pane.
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See also:

Task Editor

Tasks
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Task Grid View
The Task Grid View provides a way for Preparers and Approvers to view and work on their tasks
from within a grid. Task Grid View and Task Gantt View are where Administrators and task
Preparers can do most of their task processing.

Use the first column in the Tasks pane to select multiple tasks to process by clicking the check
box for each task.

The task list grid in the Task Grid View page works as a pivot grid, allowing column(s) to be
dragged to the top, creating groupings. Click any task in the grid to display the task details on the
bottom half of the page. The Task Grid View page reloads if any of the filters on the Task Filter
menu bar change or when you click Refresh.

Task Manager Guide 92

Task Grid View



Task Gantt View
The Task Gantt View displays a Gantt chart with dynamic filters. Tasks presented on the Gantt
chart turn from blue to red when a task becomes past due. The Gantt chart displays the Task
Details pane on the bottom half of the page. The Gantt chart times are based on the user’s
computer time.

Title
The name of the task.

Details
Click the ellipsis button in the row of the task to display its details in the Task Details pane on the
bottom half of the page.

Image
An indicator showing the task’s status.

See also: Task Status Indicator for more information about each status indicator.

%Complete
The percentage a task or task group has been completed.
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Note: If a group contains tasks that a user cannot access, those tasks are not considered in
the derived completeness calculation. This value matches the Scorecard completion value
for any given group.

Start
The local date and time the task is set to begin.

End
The local date and time the task is set to complete.
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Document Management
Use the Doc Mgmt action type to manage document workflow (such as all documents needed for
close).

Note: A Document Management task may only contain and manage a single document for
document revisions. Use task attachments if several files are required for a task.

Preparers can create, check-in, publish and modify the documents. Approvers can only publish
documents, so they can be reviewed before approval is given.

Select a Doc Mgmt task in the Task Details dialog box to display its details on the bottom half of
the dialog box. When you click Execute to execute the task, the Document ManagementMenu
Bar displays.

Document Management Menu Bar

Check-In
Use this to check-in a single document from your local computer. First enter a check-in comment
and click Check-in, then navigate to and select the document and clickOpen.

History
Opens the Check-In History dialog box to check-in a document version previously used, that is
currently stored in history.

Check-Out
Use to check-out a previously checked in version of the document.
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Undo
Use to undo document version checkout.

Publish
Use to publish the checked-in version of an XFDoc.

Delete
Deletes the document and all historical instances of the document associated with the selected
task.

Document Management Processes

Creating the Document to be Checked-In/Published
1. OpenWord and create the document containing the information related to the task.

OneStream software components are added to the document with the XFDoc Builder Add-
In during check-out.

2. Save the document and note its location.

Note: Documents inserted into other documents must be saved with .xfDoc as part of
the file name, for example SouthHoustonSales.xfDoc.docx for a Word document.
Documents not stored in this format cannot be inserted in other documents

3. Close the document.

Check In and Publish a Document
1. Click Check-In and enter a related comment In the Check-in dialog box. Click Check-in.

2. UseWindows Explorer to navigate to the location of the file being Checked-In (created in
the previous section) and select it.

Note: Documents being checked in must be closed before checking them in. An error
occurs if the document is still open.

3. ClickOpen to check in the document. The document displays in the task, with a status of
CheckedIn. The document displays a green check in the In column to indicate it is checked
in.
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The document is ready to be published if the document does not need any XFDoc
components added. Continue to the next step.

See also: Check Out and Publish a Document for instructions if you are adding XFDoc
components to this newly published document.

4. Select the newly checked-in document, then click Publish. The document opens and
displays in the program associated with the file type.

5. Close the document. The status of the document is still CheckedIn and it has a green
check in the In column.

Note: Document file name suffixes change from .xfDoc to .xfTmp when checked in.

Check Out and Publish a Document
If the document needs to be updated, it must be checked-out, edited, checked-in, and
republished. The XFDoc Builder add-in must first be installed as a Word add-in before using it in
Word.

1. Click Execute to execute the task for the document needing updates.

2. Select the document version to be updated, then click Check-Out. The document opens in
the file's default File Viewer.

3. Make any required changes needed to the document.

If not adding components, proceed to step 7. Otherwise, proceed with the next step.
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Note: The XFDoc Builder add-in must first be installed as a Word add-in before using
it in Word.

See also: XFDoc Add-Ins Settings for information on adding the XFDoc Builder add-in.

4. In Word, click Add-ins, then click the XFDoc Builder button.

5. Use theOneStream XFDoc Builder dialog box to insert components. Double-click the
content types to add them to the list of content items, and then click Insert.

The document updates with the selected component information.
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While the document is checked out for editing, the extensible functionality is not processed,
due to the .xfTmp in the file name. While editing the document, the extensible code is
visible, not the actual data.

6. Save the document. When saving the document in the same file location with its previous
name, select the Replace file option when prompted. The document automatically saves
with .xfTmp added to the file name.

7. Close the document.

8. Complete the steps documented in Checking-In/Publishing a Document to check the
document back in and publish it. When published, the document contains information
based on the components added and the formulas entered.
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Provide an explanation of what changed in the Comment field. Both versions of the
document display in the Document Management list.

Create a Combined Extensible Document
You can create a single document to display data frommultiple source documents. Each of the
source documents must have .xfdoc in the file name, be associated with a specific task, and
already be checked-in and published. Then you can combine multiple documents into a final
document. There must also be a task that creates and publishes the combined extensible
document already created.

Note: Combining oneWord document (Doc Management) task inside of another Doc
Management task (Word Document) using a version of Microsoft Word 2010 or earlier is not
supported.

1. Create a blank document in Word to contain the combined documents.

2. Enter the appropriate information into the document.

3. Save it and note the location.

4. Launch the task for publishing combined documents.
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5. Check in the document created in step 1 of this procedure.

6. Select the document that was just checked in and click Check-Out. A window displays with
options for the file being checked out.

7. ClickOpen.

8. Click Add-ins, then click the XFDoc Builder button.

9. In the XFDoc Builder dialog box, select Task Word (Document) as a content item.

10. Select the file to be inserted, then click Insert.

11. Select the next blank line in the document, then press Enter to move to a new line.

Note: Inserted files must be added on a separate line within the combined document.

12. Repeat steps 8-11 as necessary to insert all documents.

13. Save the document.

Note:When saving the document in the same file location with its previous name,
select the Replace file option when prompted.

14. Close the document.

15. Complete the steps documented in Check In and Publish a Document to check in and
publish the document.

This example shows a combined document.
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Manage Grid Items
Task Manager provides several features that let you group, filter, and display the data, items and
columns in the grid.

Group Grid Items
In Task Manager grids, you can drag and drop column headers to the dark blue bar on top of the
column headers to group and display grid items by the dropped column.

Any column or combination of columns can be used. For example, to group tasks by Status Text
and Preparer, first drag the Status Text column head up to the bar at the top of the grid, then do
the same with the Preparer column head. Dragging and dropping any column head to this area
changes it to the Grouped by bar and displays the column head names that you drop into it.

The following image shows the Task Grid View page with the tasks grouped first by Status Text,
then by Preparer.
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Column groupings are updated and display as soon as the column is dropped into the bar. When
more than one grouping is used, groupings display as nested within its higher-level grouping. For
example, the previous image lists the tasks by status, then within each status, tasks are grouped
by the Preparer.

Expand or collapse grouped items by clicking the Expand and Collapse widgets on the top left of
each grouping.

Any column groupings you make are retained between Task Manager sessions. Groupings stay
in place until you change them or remove them.

To remove a grouping, hover over the column group you want to remove, then click the x that
displays in the group box. You can also click the column group head in theGrouped by bar and
drag it anywhere outside of the bar to remove it. Removing all groupings restores the list to its
original state.

You can also change the list of items within groupings between ascending order and descending
order by clicking the ascending/descending widget on the top of the column group box.

When grouping grid items by multiple groups, you can also easily change grouping hierarchy by
dragging and dropping a grouping box to the grouping level.

Filter Items that Display in a Grid
Grids allow you to use filters to display a subset of the grid’s items. This is useful when working
with large numbers of items in a grid and lets you easily focus on the items you need to work with.

Any column reordering stays in state until you change it. In other words, column ordering is
remembered and retained from session to session until changed.

Any grid with columns that include the Filter button in the column head let you use filtering
criteria to display the items that meet the filtering criteria you define for that column.
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In any grid column, you can click the Filter button to display the Filter Criteria dialog box.

Start by selecting the specific items to include in the filter. Items that you can choose from are
based on specific item values available in the selected column. You can select all items, specific
items, or a single item for filtering.

Use the remaining fields to optionally build a filter expression to further filter the items to display in
the grid. Use the fields to define the logical operators and relational operators in the filter
expression. When a logical operator requires a value, use the text box below the logical operator
list box to enter the value. Click the button next to the value if you want case matching to apply to
the entered value.

Click Filter to apply the filter to the selected task group or task list.

Reorder Grid Columns
Each column in a grid can be moved, so you can customize the display order of columns. This is
useful with grids that display many columns, letting you customize the display order to see the
column data most important to you. This lets you move the most important columns to the visible
area of the grid, so you don’t have to scroll right and left to see those columns.

To reorder a column in a grid, click and drag the column heading to a new position in the grid.
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Set and Order Grid Columns (Task
Administration only)
In the Task Administration page, you can use the Column Settings dialog box to determine
which columns to display and the left-to-right order in which the columns display. You can column
display and ordering for both the Task Group and Task list panes. This allows you to easily focus
on just the data you need to see to process your task groups and tasks.

See also: Column Settings for instructions on setting Task Administration column ordering and
display using the Column Settings dialog box.
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Process Tasks in Bulk
The Task Grid View and Task Details dialog box allow you to update multiple task statuses by
selecting the tasks, then applying one status action to all the selected tasks. For example, rather
than selecting each task that needs approval and changing the task status to Approve one-by-
one, you can select all the tasks and approve them all in one mass action.

Processing tasks in bulk is an efficient time saver when you need to perform the same task status
action on many tasks at once. You can approve, unapprove, complete , reject, or recall multiple
tasks by selecting them and performing a mass task status action on all the selected tasks at
once.

All buttons display regardless of your role. Once you apply the action each selected task is
validated against your rights. If you do not have access to that action the selected tasks do not
update.

Task Manager statuses indicate where a task currently is in the task workflow.

See also:

l Mass Updates Settings for information on managing what can be updated in bulk.

l Task Status Actions for a description of each task status by role.

l Task Manager State Diagram for an overview of the task status workflow.
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When you select multiple tasks, the Task Detail pane changes to a grid listing all the selected
tasks. Task status icons display at the top to let you update all the selected task’s statuses. Icons
that display are based on the task statuses you can apply for your role.

See also: Task Status Actions for a description of each task status by role.

To update multiple tasks at once:

1. Select all of the tasks to process. You can select multiple tasks by:
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l Click the first task in a consecutive range, Hold SHIFT, and click the last task in the
range.

l Hold CTRL and select multiple, non-consecutive tasks.

l Click the check box in the leftmost column header. This selects all tasks in the list.

2. Click the applicable icon in the Task Status menu bar to update the tasks. Only the actions
that can be taken on the selected tasks are made during processing.

When bulk processing, Task Manager considers the task dependencies, task type, the current
task status, and your role with the task to determine which selected tasks can be updated. Mass
actions cannot be applied to the following task types:

l OpenWorkflow

l Dependent Group

l Data Management

l Any Custom Task that has any character in the Auto-Status function field.

When the selected tasks are updated, a message displays showing the number of tasks that were
changed to the new status and the number of selected tasks that were not actionable and did not
update.

When you clickOK and apply the bulk changes, the top grid does not refresh. This is so you do
not lose their selected tasks in the list. However, the bottom grid of selected tasks does reflect the
status change. Click the Refresh button to update statuses in the top grid.
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Help and Miscellaneous
Information

This page contains additional solution documentation for Task Manager.

Display Settings
OneStream and MarketPlace solutions frequently require the display of multiple data elements for
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of
1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to
100% and do not apply any Custom Scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the Platform. Renaming
any of the elements contained in a package is discouraged in order to preserve the integrity of the
naming conventions.

Example Package Name: UTM_PV6.3.0_SV101_PackageContents.zip

Identifier Description

UTM Solution ID

PV6.3.0 Minimum Platform version required to run solution

SV101 Solution version

PackageContents File name

Task Manager Guide 110

Help and Miscellaneous Information



Solution Database Migration Advice
A development OneStream application is the safest method for building out a solution with custom
tables such as this one. The relationship between OneStream objects such as workflow profiles
and custom solution tables is that they point to the underlying identifier numbers and not the
object names as seen in the user interface. Prior to the solution configuration and to ensure the
identifiers match within the development and production applications, the development
application should be a recent copy of the production application. Once the development
application is created, install the solution and begin design. The following process below will help
migrate the solution tables properly.

See also:Managing a OneStream Environment in the Design and Reference Guide.

1. In the production OneStream application, install the solution and create the data tables.
See for Database Server Connection settings and installation details.

2. Data tables are created in the OneStream Development application during the solution
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to
the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator
should run the migration assistant.

Important: This process has the potential to overwrite existing table data in the production
application database if data already exists.

MarketPlace Solution Modification
Considerations
A few cautions and considerations regarding modification of MarketPlace solutions:

l Major changes to business rules or custom tables within a MarketPlace solution will not be
supported through normal channels as the resulting solution is significantly different from
the core solution.

l If changes are made to any dashboard object or business rule, consider renaming it or
copying it to a new object first. This is important because if there is an upgrade to the
MarketPlace solution in the future and the customer applies the upgrade, this will overlay
and wipe out the changes. This also applies when updating any of the standard reports and
dashboards.
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l If modifications are made to a MarketPlace solution, upgrading to later versions will be more
complex depending on the degree of customization. Simple changes such as changing a
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the
custom database tables and business rules, which should be avoided, will make an
upgrade even more complicated.
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Appendix A
Task Manager State Diagram
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Appendix B: Custom Event Model
The purpose of the Custom Event Model is to provide a method in which you can add
customizations to the Task Manager solution that remain in place and are bypassed during a
solution upgrade. The Task Manager solution supports these models using Business Rules.

Set Up the Custom Event Model
1. On the Application tab click Dashboards > Dashboard Maintenance Units > XFW Task

Manager (UTM) > Files.

2. In the Files folder, clickCustomEventHandler_UTM.zip.

3. In theGeneral (File) pane, click Download File in the Content file field and save the file to
an appropriate location.
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4. On the Application tab, click Tools > Load/Extract.

5. On the Load tab, locate CustomEventHandler_UTM.zip using the Select File icons and
clickOpen.

6. When the solution’s file name displays, click Load to import the business rule.

Integrate Business Rules
After importing the business rule, update the UTM_EventHandler business rule to integrate with
the CustomEvents business rule.

1. Click Application > Tools > Business Rules.

2. In the Business Rules Navigator, open the Dashboard Extender folder and click UTM_
SolutionHelper to display the Solution Helper properties.

3. In theGeneral section of the UTM_SolutionHelper script Properties tab, add
BR\CustomEvents_TaskManager to Referenced Assemblies. Click Save.

4. In the Business Rules Navigator, click UTM_EventHandler.

5. In theGeneral section of the UTM_EventHandler script Properties tab, add
BR\CustomEvents_TaskManager to Referenced Assemblies.
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6. Click the Formula tab to display the script and comment out line 42 of the UTM_
EventHandler business rule.

7. Uncomment line 43 of the UTM_EventHandler business rule. Click Save.

Once the custom event integration is set up, event actions can be defined in the CustomEvents_
TaskManager script.

Note: These events are not deleted or overridden when upgrading to new versions of Task
Manager. However, each time a new version is upgraded, apply these setup steps.

Available Custom Events
Before/After Selection Changed Events
The following events run before/after a custom control is clicked:

l SaveSettings

l CreateSolutionTables

l ValidateSetupStepsExecuted

l Uninstall
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l OnTableEditorOrGridSelection

l OnComboBoxSelection

l OnButtonClick

l OnShowContentPage

Before/After Save Data Events
The following events run before and after the save event for a table editor. Use these events to
test grid data prior to saving and potentially not allowing the data to be saved if a check fails.

l OnSaveOrUpdateTableEditor
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